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DESCRIPTION 

This training document introduces you to using Pivot Tables and Pivot Charts within 

Excel 2007. You will learn how to use pivots to manipulate data available in an Excel 

spreadsheet. You will work with columns and rows, and learn how to summarize data, 

such as the Sum and Average functions. You will learn how to open and use PivotChart 

Tools, including chart types, chart designs, and add chart titles. This training will also 

instruct how to import data from an external source. 
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Module 1: What is this Pivot Thing Anyway? 
 

Learning Objectives 

After completing this module, you will be able to: 

1. Define what pivot does. 

2. Create a pivot table. 

3. Manipulate data in a pivot table by moving columns and rows. 

4. Summarize Data by using common functions, such as Sum and Average. 
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Overview of PivotTables and PivotCharts 

There are a lot of ways to summarize, analyze, and display data in Microsoft Excel 2007. You can 

order data, filter data, sort data, analyze data by using statistical and financial functions, create 

pie charts, line charts, and scatterplots, create…. Well, you get the idea. 

Also on the list of usable tools in Excel 2007 are pivot tables and pivot charts. Not only are pivot 

tables and pivot charts really hip buzzwords, it turns out the pivot tables and pivot charts are 

really cool ways to aggregate and analyze data in new ways. In some respects, you can think of 

pivot tables and pivot charts as down-level versions of data mining (now there’s a buzzword for 

your next party). 

But, why are they called pivot tables and charts? Well, because you can pivot columns and rows 

in a workbook. In other words you can make columns into rows and vice versa. 

But, what good does that do? Is that really useful? Let’s take a look at an example. Suppose a 

client brings you an Excel workbook that contains the following sales data: 

 

Your client wants to analyze this data to determine the most profitable product line. She would 

also like to know the region with the highest sales. You could manually total the information. 

However, this would require a calculator (it’s in the bottom drawer of your desk underneath the 

slide rule), and some fumbling about with a stone and chisel, err, pen and paper.  
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You could create several worksheets, and use the tools in Excel to filter and sum the data. 

There’s a lot of bother with that one, too. Still another possibility is to export the data to Access, 

and use queries to extract the information. The Access option has lots of possibilities, but let’s 

try using a pivot table to analyze the data. 

For now, we’re going to create a pivot table using the data in the workbook. Don’t worry, we’ll 

show how to create a pivot table shortly. For now, let’s look at the results to see if this pivot 

table thing is worth the effort. 

After we create a pivot table using the data above, it looks something like this: 

 

Good stuff. When we create a pivot table, a default configuration of Excel (we’ll discuss the 

options in Excel later) not only generates the product sales for each sales region automagically, 

but also sums the product sales for each region. Excel also calculates the grand total for the 

sales for all products in all regions! How cool is that? 

Well, pretty darn cool if you ask us. Creating the pivot table took a couple of minutes. By 

inspecting the data in the pivot table, we can determine that Tickers are the best selling 

product, and the highest sale total for the pivot table was in the North sales region. Yup, they 

like their Tickers up North. 
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Because the client also wants to know about sales figures by region, we must also calculate that 

data. Not to worry, we can calculate that data with a single click of the mouse: 

 

Now that’s very cool. By changing the pivot table options, we can now provide the client with all 

of the data that she requested. We can tell that Tickers are the best selling product (in terms of 

gross sales anyway), and that the West sales region has the highest gross sales. We can also 

inform the client that Sprockets don’t sell that well, especially in the South and West sales 

regions. 

So, maybe we should have a closer look at this pivot table thing. It looks like pivot tables are a 

neat way to display data from an Excel workbook. But what about pivot charts? 

Pivot charts are just the data from an Excel workbook represented in a graph format. And, 

charts look good in PowerPoint presentations. So let’s take a look at a pivot chart of the data: 

 

Excel creates a pivot table similar to the one that was created earlier in this section. And, also 

creates a chart, in this case a column chart that displays the same data in a graphic format. 

Depending on the subject, audience, and venue, you can choose to use one the pivot table, 

pivot chart, or both. 
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And, like the pivot chart, you can easily change how the workbook data appears in the pivot 

chart: 
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You can also easily change, in a mouse click or two, the type of chart that is used. For example, 

you can choose to display the data in a bar chart, and then change the chart style as well: 

 

 

If you’re still on-board, let’s see how to create and tweak pivot tables and pivot charts. 
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Creating Pivot Tables 

First, we’ll need some data. Let’s go ahead and use the data that appeared earlier in this section: 

 

As mentioned earlier, the client would like to know the product with the highest gross sales. She 

would also like to know which sales region has the highest gross sales. There are a number of 

ways to calculate this data. However, we decided to see if creating a pivot table or pivot chart 

would be a quick and effective way to provide this information to the client. Let’s see if that’s 

true. 

To create a pivot table, click the Insert tab, click PivotTable, and then click PivotTable: 
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In the Create Pivot Table dialog box, click the Table/Range icon to select the data that you want 

to analyze: 

 

In the dialog box, you can either type the cell references for the range of data that you want to 

analyze, or you can click and drag to highlight the range. In this example, we used the click and 

drag method to highlight the range of data: 
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After you define the range that you want to analyze, click the Table/Range icon again: 

 

In the Create PivotTable dialog box, click Existing Worksheet, click the cell where you want to 

insert the pivot table, and then click OK: 

 

After you click OK, the pivot table and PivotTable Field List dialog box appear. Notice that there 

is no data in the pivot table yet: 
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To populate the pivot table, we need to select the data fields that we want. To start, in the 

PivotTable Field List dialog box, click the Product check box: 

 

The Product field is added to the pivot table as expected. To continue populating the pivot table, 

click the Sales Region check box, and then note how the pivot table changes: 
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To finish populating the pivot table, check the Sales check box: 

 

Now, we have some usable data for the client. As we demonstrated earlier in this section, we 

can now see that Tickers are the best selling product, at least in terms of gross sales. We can 

make the product gross sales comparison even easier if we collapse the detail view for each 

product: 
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After you collapse the detail view, the pivot table should look like this: 

 

However, we cannot easily determine the sales region with the highest gross sales. How can we 

display the sales figures for each region? Well, let’s “pivot” the table by manipulating the 

columns and rows.  

Before we “pivot” the table, let’s take a minute to think about what we’re trying to accomplish. 

The pivot table, before we collapsed the detail view, looked like this: 
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To display the sales data by region, we need to manipulate the data by moving either “Products” 

or “Sales Regions” to a column. Let’s try moving “Products” to a column first. To do this, right-

click a product, “Sprockets” for example, click Move, and then click Move “Product to Columns”: 
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After you click Move “Product to Columns” the pivot table should look something like this: 

 

 

We could have chosen to move the sales region to a column and gotten similar results. Let’s try 

that, and we’ll also see how easy it is to make changes to a pivot table. To undo, the current 

table formatting, just click the Undo button in the title bar: 

 

Note: You can also use the CTRL+Z keyboard command to undo an action. 

After we click the Undo button, we’re back to the original pivot table format: 
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To make “Sales Regions” into columns, just click a sales region, “East” for example, click Move, 

and then click Move “Sales Region” to Columns: 

 

After you click Move “Sales Region” to Columns, the pivot table should look something like this: 
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You may experience an alignment issue in the column headings. In this example, the alignment 

of the“East” sales region column label may be confusing: 

 

To fix this, click the cell that is not aligned correctly, and then click the alignment that you want 

in the Alignment area on the Home tab: 

 

 



  

 

Excel 2007 Pivot Tables and Pivot Charts 2
1 

 

Finally, the client asks if you can provide an average of sales both by product and by sales region 

for comparison purposes. To do this, right-click the pivot table, click Summarize Data By, and 

then click Average: 

 

After you click Average, the pivot table should look something like this: 

 

When we created a pivot table earlier, you may have noticed that you can use data from an 

external source when you create a pivot table.  The other item to know is how to update or 

refresh your pivot table when a data source is changed. 
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Bringing in an External Data Source 

To use an external data source to create a pivot table, click the Insert tab, click PivotTable, and 

then click PivotTable: 

 

 

In the Create PivotTable dialog box, click Use an external data source: 
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Click Choose Connection: 

 

In the Existing Connections dialog box, click the connection that you want, or click Browse for 

More: 
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In this case, we’ll use an Access database file named ExcelDemo.accdb as the external data 

source. The data in the Access file looks like this (you’re probably pretty darn familiar with this 

data by now): 

 

In this case, the ExcelDemo.accdb file is located in the My Documents folder. In the Select Data 

Source dialog box, you would browse to the My Documents folder, click the ExcelDemo.accdb 

file, and then click Open. 

After you click Open, the Data Link Properties dialog box appears. Verify that the information on 

the Connection tab is correct, and then click OK: 
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If necessary, verify that the initialization information is correct, and then click OK: 

 

Note: that the connection name now appears in the Create PivotTable dialog box: 

 

In the Create PivotTable dialog box, verify that the location where you want to insert the pivot 

table is correct, and then click OK. 
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After you click OK, the PivotTable and the PivotTable Field List dialog box appear: 

 

From here on, it’s just like creating a pivot table: Click to select the Product, Sales, and Sales 

Region dialog boxes, and then click OK. After you click OK, the pivot table looks oddly familiar: 

 

That’s because it is the same as a pivot table that uses Excel spreadsheet data.
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More Pivot Manipulation 

The client appreciates the quick analysis you provide. She appreciates it so much that she 

returns a couple of days later with a more detailed workbook. The data in the workbook is as 

follows: 
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She asks you do a similar analysis using the more detailed set of data. You agree, and create a 

pivot table from the data: 

 

 

After you move “Products” to columns, the pivot table looks like this: 
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In looking over the data, your client notices that the grand total of sales numbers for the “Small” 

version outsell the “Large” version in the North, South, and West sales regions. However, the 

“Large” versions are the best seller in the East sales region. She asks if she can view the sales 

data for the East sales region only. 

To do this, you click the dropdown for Row Labels, click to clear the North, South, and West 

check boxes, and then click OK: 

 

The pivot table looks something like this: 

 

After you reconfigure the pivot table to display sales data for all regions, your client notices that 

“Sprockets” line seems to have the lowest sales. She also notices that the “Tickers” line is the 

best selling. She would like to see the sales figures for those two lines side-by-side.  
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To do this, you click the dropdown for Column Labels, click to clear the “Cogs” and “Widgets” 

check boxes, and then click OK: 

 

 

After you click OK, the pivot table looks like this: 
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Module 2: Pivot Charts 
 

Learning Objectives: 

After completing this module, you will be able to: 

1. Create a pivot chart. 

2. Manipulate data in a pivot chart. 

3. Customize the pivot chart design. 

4. Change the pivot chart type. 
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Creating Pivot Charts 

That’s the basics of pivot tables. The previous pages beg the question: Are pivot charts just as 

easy? Yeah, pretty much. Let’s check it out. 

We’ll use the same data set for this example: 

 

To create a pivot chart, click the Insert tab, click PivotTable, and then click PivotChart: 

 

When you click PivotChart, the Create PivotTable with PivotChart dialog box appears. As 

mentioned earlier, a pivot table is automatically created when you create a pivot chart. You 

almost expect a rousing “But wait… there’s more!” at this point. 

The Create PivotTable with PivotChart dialog box resembles the Create PivotTable dialog box.  
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Ok, it’s exactly like the Create PivotTable dialog box: 

 

As when creating a pivot table, you can click and drag to select the cells that you want to use, or 

you can type the range in the Table/Range box. Just for a change, we’ll just type the range this 

time: 
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Let’s go ahead and insert the pivot table and pivot chart on a separate worksheet. To do this, 

click the Location icon: 

 

To create the pivot table and pivot chart, click the worksheet and then the cell that you want. In 

this example, we’ll insert the pivot table and pivot chart in cell B2 on Sheet5: 

 

 

After you select the worksheet and cell, click the Location icon again: 
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Verify that the Table/Range and Location values are correct, and then click OK. After you click 

OK, both the pivot table (as expected based on our experience creating pivot tables) and pivot 

chart are blank: 

 

To populate the pivot table and pivot chart, click to select the fields that you want in the 

PivotTable Field List dialog box: 

 



  

 

Excel 2007 Pivot Tables and Pivot Charts 3
7 

 

Let’s see what happens if we pivot the data. Right-click “Sprockets” in the pivot table, click 

Move, and then click Move “Product” to Columns: 

 

After you click Move “Product” to Columns, the worksheet should look something like this 

(although you may have to move some stuff around): 
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When we pivot the data, the chart changes as well. One good way to see the difference is to 

examine the PivotChart Filter Pane. Before we “pivoted” the data, the PivotChart Filter Pane 

looked like this: 

  

After we “pivot” the data, the PivotChart Filter Pane looks like this: 
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Customizing the Chart 

So, now that we have a chart that represents the data in the pivot table, let’s customize the 

chart a little. When you click on a cell outside of the pivot chart, notice that the right side of the 

Office ribbon looks like this: 

 

Now click on the pivot table. When you click on a cell in the pivot table, the right side of the 

Office Ribbon looks like this: 

 

The PivotChart Tools menu item is a contextual tab. Contextual tabs are a new feature in Office 

2007. These tabs appear when you click on certain objects. Another example of a contextual tab 

is the Picture Tools contextual tab that appears when you click a graphic file in Word 2007. 

But, back in Excel 2007, the PivotChart Tools tab appears when you click in a pivot chart. When 

the PivotChart Tools tab appears, you can click on the Design, Layout, Format, or Analyze to 

customize the pivot chart. 

For example, the following items appear on the PivotChart Tools contextual tab when you click 

Design: 
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Let’s change the chart style for the pivot table. To do this, click Change Chart Type: 

 

When you click Change Chart Type, the Change Chart Type dialog box appears. You can select 

from column charts, pie charts, stock charts, doughnut charts, and bubble charts (yeah, I didn’t 

know either. Turns out that bubble charts are a version of scatter charts.). In this case, let’s be a 

little cautious, and just go with a bar chart: 
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After you click OK, the pivot chart now looks like this: 

 

Let’s do something about those colors as well. They painted Mercedes-Benz sedans those colors 

back in the ‘70s. You can select from the default chart styles in the Office Ribbon, or you can 

click the More button, and select from a lot more styles: 

 

After you click the More button, you can choose from a palette of styles: 
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After choosing the style that you want, the pivot table looks something like this: 

 

More better, at least from here. Your mileage may vary. In any case, let’s add a chart title. To 

add a chart title, click Layout, click Chart Title, and then click the chart title type that you want: 
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Choose Above Chart, and type a chart title: 

 

You can also click Axis Titles, to add axis titles to the horizontal and vertical axes: 

 

After you add titles to the horizontal and vertical axes, the pivot chart might look something like 

this: 

 

Maybe a little busy, but it’ll do. 
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Refreshing a Pivot Table / Chart 

So, what happens if the data in a worksheet changes and you need to update a pivot table? Do 

you have to delete the existing pivot table and/or pivot chart and create a new one? 

For example, your client calls and apologetically says that some of the data in the original 

worksheet was not correct. You might remember that she was surprised by the lackluster sales 

of the Sprockets line. She brings over the updated worksheet for you to analyze. 

The Sprockets sales figures in the original worksheet looked like this: 

 

The pivot table for this data currently looks like this: 

 

However, the updated (and correct) sales figures for the Sprocket line look like this: 

 

So, after you update the worksheet to include the correct sales figures, how do you update the 

pivot table data? Pretty easily as it turns out. To update the pivot table, just right-click the pivot 

table and then click Refresh: 
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After you click Refresh, the pivot table looks like this: 

 

 

Conclusion 

So, that’s it for pivot tables and pivot charts. As we’ve seen, pivot tables and pivot charts are a 

quick way to look at data in different ways. Because data mining is the transformation of data to 

see hidden patterns, pivot tables and pivot charts can be thought of as a simpler version of data 

mining.  

Pivot tables not only let you look at data in different ways, but you can also change the way data 

is summarized. For example, you can not only sum data, but also use counts, averages, 

maximum, and minimum. Number geeks rejoice. 

Pivot charts are a great way to prepare data for presentations. Because lots of numbers may 

divert the attention of an audience from the main message of a presentation, you can often use 

pivot charts to support, rather than overwhelm, the main points in a presentation.  
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Final Exam Questions 

1. In the Create PivotTable wizard, use which selection to bring information not within an 

Excel worksheet? 

a. New Worksheet. 

b. Select a table or range. 

c. Existing Worksheet. 

d. Use an external data source. 

2. Pivot Tables & Charts are great ways to help analyze, sort and filter data. This done by 

what process? 

a. Manipulating columns and rows of a targeted range of data from a worksheet. 

b. Manipulating cells and rows of a targeted range of data from a workbook. 

c. Manipulating cells and columns of a targeted range of data from a worksheet. 

d. Manipulating columns and rows of a targeted range of data from a workbook. 

3. To select cells of the current Excel worksheet to be used, use which step in the Create 

PivotTable wizard? 

a. Choose use an external data source. 

b. Choose existing worksheet and give it’s location. 

c. Choose New Worksheet. 

d. Choose Select a table or range, then click the Table/Range icon and choose your 

cells. 

4. The original worksheet has been updated, how do you update the PivotTable? 

a. Press F5 on the keyboard. 

b. Right-click the pivot table, then click Refresh. 

c. Right-click the pivot-table, then click Summarize by. 

d. Click View, then Refresh. 

5. To perform a function, such as Average or Sum, which would you choose after right-

clicking the pivot table? 

a. Summarize Data By 

b. Value Field Settings 

c. PivotTable Options 

d. Format Cells 
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Fig. 1       Fig. 2 

6. To get from Figure 1 to Figure 2, you have chosen which of the following after right-

clicking the pivot table? 

a. Move “Sprockets” to Beginning. 

b. Move “Products” to Columns. 

c. Move “Sprockets” to End. 

d. Move “Products” to Right. 

 

 Figure 3. 

7. In Figure 3, you need to filter the view to see only the data for “North.” Which steps are 

correct? 

a. Right-click the pivot table, choose Value Field Settings. 

b. Right-click the pivot table, choose Hide Field List. 
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c. Click Column Labels drop down, and de-select the items not needed. 

d. Click Row Labels drop down, and de-select the items not needed. 

8. When you create a PivotTable and add fields to the report, a default table layout is used. 

How do you change the PivotTable layout? 

a. Drag and drop the fields from the PivotTable Field List. 

b. Right-click the field, click Move, and then choose where to move the field. 

c. Use the Move Field feature. 

d. Click the Data table, and then click move. 

9. Which of the following is not an option when you change how data is summarized in a 

PivotTable? 

a. Min 

b. Average 

c. Standard Deviation 

d. Count 

10. Which of the following is not an available chart type in the change Chart Type dialog 

box? 

a. Doughnut 

b. Bar 

c. Area 

d. Float 

 

 


